AASHTO TRNS*PORT® ESTIMATOR™ v2.9a
Step by Step Users’ Guide for SHA Estimates
2012

Introduction: Trns-port Estimator was developed by Info Tech, Inc. for transportation agencies and their
design consultants. It is licensed nationwide by the American Association of State Highway and Transportation
Officials (AASHTO). Data for producing estimates is stored in one or more catalogs that include: category code
book items, wages, production rates, historical item price data, and equipment and material costs. It is
designed to upload to the Trns-port Proposal and Estimates System (PES).

Starting the Estimator 2.9a program for the first time.

The First time you use this software application on your computer, you will need to enter the expiration key
before you can login. Please follow the instructions on the screen (as shown below).

p

Key Required

| This program requires an expiration key, If you have one, select OK to enter it. After entering a valid key, you will not be prompted again.

Cancel ‘

r Erter Expiration ey @

Enter the Eztimator zenal number and expiration key below,
exactly as given to o,

E ztimator Serd: ||

E=piration Key: |

k. | Cancel

4 I
Key Walid

'0' Key is walid and has been stored,
Ok
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Estimator Login

Izer Mame: ||

Pasgword: I

Cancel |

Add Catalog (This needs to done the first time only):
e Download the latest catalog from the SHA Internet site (MDCATALOGOS).
e C(Click on Under the Tools menu, click Add Catalog.
e Navigate to where you saved the catalog and click on MDCATALOGOS.



Creating an Estimate Header

e (Click the New Icon (White sheet of paper on Tool Bar) or under the file menu, Click New.
e Select Edit from the menu bar, then

e click on Estimate Options and

o check “Only Trnseport items and codes allowed”.

e (lick OK to close the dialog box and begin entering data.

‘ Estirnatar

File Edit ‘iew Tools “indow Help

0=

E Estimate MO2615177

o

[= = [ &

-y, Project Ma, MO2615177

Estimate |D: [MO2615177 Work Type: [83 ~~| |URBAN STREET RECONS
Spec ‘ear |03 Highway Type: |34RE | |SAFETY AND RESURFACE
Base Date: Im Urban/Rural Type: |UF|BN ﬂ |UF|B.-’-\N
UnitSpstem: [E 7] Season: [SPRI ~| [SPRING
Longitude of Midpoint: IW[DDDMMSS] County: |MEI ﬂ IMONTGOMERY
Latitude of Midpoint: [330000 (DDMMSS) Distrct: |3 =11

Sl | Estimate Cost: 704,519.75
SUBISV LA 0515177
Project Mumber: Contingsncy % Iillﬂﬂ J

Estimate Total: 0451975

Drezcription

olrlujsl =E=|

kD 410 from Park dvvenue to MO ER0 [Safety and Resufacing)

Page1 | Page 2 | Motes |

Ready MLURA
Page 1 Tab: Type in fields required by your SHA Division, i.e, OOM, OOS, OHD.
Estimate ID: Type the contract number in this field.
Base Date: Enter Bid Opening Date if known or 1 year from the date estimate’s created.

Longitude of Midpoint:

Enter 770000, if project’s actual Degrees, Minutes and Seconds are unknown.

Latitude of Midpoint:

Enter 390000, if project’s actual Degrees, Minutes and Seconds are unknown.

Work Type: Select from drop down menu (arrow). See the last digits of the Contract No. for
the funding source.

Highway Type: Select from drop down menu (arrow). See Ad Schedule: Type of Work —
Geometric Improvements, Safety & Resurfacing, Bridge Widening, Wetland
Mitigation, Noise Barrier.

Season Select the season from drop down menu (arrow) when the Notice to Proceed
(NTP) will occur.

County: Select from drop down menu, which is the first 2 letters of the contract number.

District: Select one district reference associated with the project’s county from 1 to 7.

Federal/State Project
Number:

Enter Federal Aid Programming (FAP) Number, State Funded or N/A.

Description:

Enter your project description such as MD 36 AT 0.16 MILES SOUTH OF JEALOUS
ROW (MOUNT SAVAGE) — EMERGENCY SLIDE REPAIR.

At this point you will see your estimate begins to build on the left side of the screen.




Page 2 Tab:

‘ Estirmator EI

File Edit “iew Tools Window Help
D@ o o) BRS| |t =

E. Estimate MO2615177
@_ Project Mo, MO2615177

M ame Date
E stimated By: ITnm Revells Iﬁ'12a’ 5/2m1 j

Checked Bu: ITnm Revells Iﬁ'12a’ /2011 j

Appraved By ITUITl Revells ITJ'IEJ'I 2/20M j

Estimate Type: [SAFETY AND RESURFACING |

Page1 Page? I Mates I

Groups I All lkems I Eutra Data I

Ready LT
Estimated By: Name of person creating the estimate—defaulted to OWNER’s name.

Checked By: For person checking estimate.

Approved By: For person who approves an estimate.

Estimate Type: Currently Not Used by SHA, but “Highway Type” can be entered.

Notes Tab: Enter any notes needed to describe your estimate.




Saving an Estimate

Estirnator Options @

General | Mumeric/Rounding URLs | Intermet | Prosy | Tree Labels |

Catalog Path [HT TP or file]:

|C:\F'n:uglamData\Estimatnl\catangs Browse

Estimate Folder:

|C:\PrnglamData'\Estimatnl'\Estimates\ Brinwze

Estimate Template Folder:

|I::'\F'logramD atahE gtimatorh Templatesh, Browse

Report Template Folder;

|I::'\F'mgramData\Estimator'\Heports'\ Browse
Cache Folder:
|C:'\F'n:uglamData'\Estimatnl\estcache Browse

IR

| Help |

ak | Cancel

Settings for Where Your Files are Saved
e Select Global Options from the Tools menu.
e (Click on URL’s tab to display the above options.

This page contains the paths for your catalog directory, your estimate directory, and your template folder.
DO NOT CHANGE THIS PATH

This is the directory to which new estimates are saved. Default
to Local Drive C:\ProgramData\Estimator directory

This is the directory where estimate templates are kept.

Catalog Path
Estimate Folder

Template Folder

REMEMBER: Estimator Global options are set to SAVE every 15 minutes.

However, save often in case of a power outage etc.
Select SAVE AS from the FILE menu the first time you save. Set up the drive and folder where you want to
save your estimates. Your contract number should automatically appear in the File Name field.

e Tosave an estimate already saved once, Select FILE and SAVE.



Change Window View:

To see the full screen, click on the full screen (maximize) windows icon on the upper right title bar or select

Tile Horizontally from the Window menu.

The left side of the window pane is called the Tree Area. Usually on the right side of the pane is the Grid Area.
The Grid area displays a list of the items selected in the tree area.

Adding Estimate Group(s): (funding, items, item prices)

Estimate groups consist of items and the item price basis.

& Estimator - [Estimate MO2615177] =N <=
E File Edit ‘iew Tools indow Help - | & %
DEE v & & a4 o’
=8, Project Mo, MO2615177
Group 0001 Prelimi Eel 0005 Group (385 504,75
[]"E].- raup reliminary Mumber: Tatal e
[]--&]_ Group 0002 Grading
-}, Group 0003 Drainage Alt Code:

o | Hern 500000-
T Ierm 504102
I Iem 50462
T Ierm 504422
T Ierm 504440
T Ierm 504600
T Itern 504605
T Itern 504610
T Itern 530100
T Itern 535100
T Iern 585405
T Iern 585407
T Itern 585621
I Ierm 585625
I e 585627

e IO OO OO OO OO OO OO e OO o OO o OO e OO o OO o

Feady

£ Group 0005 Paving

Y

N

Group Description

Bl 7|

Paving

Ttern 504440

HOT MLE ASPHALT SUPERPANE 25.0MM FOR PARTLAL DEPTH PATCH, PGA4-22, LEVEL-2

Price: 140.00000

Source: Ad Hoc

[ Group 0006 Shoulders
-8, Group 0007 Landscaping
B~ Group 0008 Signal and Lighting

Group 0009 Miscellaneous

Page1 | Motes |

i
&
&
@/
&
&
&
[
4

Line #/| Item # | Quantity

0o0z7
ooz
0023
0030
003
nozz2
0033

504102
G04168
504428
504440
504600
504605
504610

10.00
1.438.00
g10.00
92.00
10.000.00
5.033.00
5.033.00

Unit |Unit Price
TOM  100.00000
TOM  100.00000
TOW 15000000
TOM 14000000
Ed 1.00000
Ed 1.00000
Ed 1.00000

Extension | Alt Code
1.000.00
143,800.00
121.500.00
12,880.00
10.000.00
£.033.00
5.033.00

Deszcription *
HOT M= ASPHALT SUPERPAVE 9.5

HOT M= ASPHALT SUPERPAVE 3.8
HOT M= A5PHALT SUPERPAVE 25—
HOT M= ASPHALT SUPERPAVE 25
FRICE ADJUSTMENT FOR ASPHAL
PAYMENT ADJUSTMENT FOR PAVE

PAYMENT ADJUSTMENT FOR HOT -
4

ltemsz | Ewtra Data |

MURA




Group Headers

& Estimator - [Estimate MO2615177] =N = <=
E File Edit View Tools Window Help - || & =
O - v & & & 7
=8, Project No. MO2615177 Estimate ID: [MO2615177 Wiork Type: |33 ~| |URBAN STREET RECONS

[]--&l Group 0001 Preliminary )
B, Group 0002 Grading Spec Year |08 Highway Type: [SARE = | |SAFETY AND RESLRFACE
B}, Group 0003 Drainage Base Date: |12/ 5/2012 = Urban/Fural Type: |UREBM = | |UREAN
[]--El Group 0005 Paving .
Urit System: |E - Season: |SPRI | |SPRIMG
[]--El Group 0006 Shoulders IS pSAEL | J |
EJ--% Group 0007 Landscaping Longitude of Midpeint: [770000  [DDDMMSS) County: MO ~| [MONTGOMERY
-8}, Group 0008 Signal and Lighting . L District:
Latitude of Midpoint; | 330000 tstnct. |3 2
El Group 0009 Miscellaneous EHREEET Il IDIBLAL 5] | J |
Group 0010
Bl Group Feseie | Esfimate Cast 704519.75
BOBISVaLAE 0 ag 5177
FEe R Contingency &: Q.00 J
Estimate Total: 70451375
Description
Page1 | Page 2 | Mates |
Group Name Group Total Alternate Code D escription =
@ | 0om 235.032.00 Preliminan
@ | oo02 3.060.00 Grading
@ | o003 .00 Drainage
@5 | 0005 385,504.75 Paving
@ | 000e 7720300 Shoulders
.[ ooy 2,220.00 Landscaping
.[ ooos 1.500.00 Signal and Lighting
.[ ooo9 0.00 Mizcelaneous ]
® I
< | | D
Groups | Al ltems | Eutra Data |
Ready MUk

ADD Group Header
Once a group is created, the group header information must be completed. After the group header
information is filled out, you can start adding items to your group.
e Click on 0001 under Group Name.
e Tab to Description.
e Type in the Category Title such as Preliminary, Grading, Drainage, Structures, Paving, Shoulders,
Landscaping, Traffic Signals & Lighting, etc.



NOTE: left side tree area pane now has the header and the group (funding).

& tstimator - [Estimate MO2615177] ===
E File Edit View Tools ‘Window Help [= =] %]
DEEw | RS et | |
E--{ﬁérloject Mo, MOZ61517T Estimate [D: |MOZE15177 whork Type: |83 =| |URBAM STREET RECONS

M- Group 0001 Prelirminary )
= W), Group 0002 Grading Spec Year 0B Highway Type: [S4RE  ~| [SAFETY AND RESURFACE
.|, Group 0003 Drainage Base Date: [12/ 5/2012 | UrbandRural Type: [UREN | JURBAN
[]—-El Group 0003 Paving .

Lt Syt :IE 'I Seazon: |SPRI *| |SPRING
[]—-m Group 0006 Shoulders M I J I
[]--El_ Group 0007 Landscaping Longitude of Midpoint, [770000  [DDDMMSS) Couirty: IMD j IMDNTGDMEHY
[]—-El Group 0008 Signal and Lighting . L District:

Laitude of Midpoint. [330000 istnct: |3 hd
El Group 0009 Miscellaneous ELR B e (DDMMSS) I J I
El_ Group 0010 Example Group Description )
Estimate C t:l 704519.75
Federal/State Slmae o8

Ready

[~ Diescription
Page 1 |Page2| Motes |

Froject Mumber:

|MO2E15177

Contingency % I—DEIEI J
Estimate Tatal: I 70451375

Group HName | Group Total Alternate Code Description
@@ | 0001 23503200 Preliminary
@ | 0002 3.060.00 Grading
.[ ooo3 0.00 Drainage
@@ | 0005 385.504.75 Paving
@@ | 0005 77.203.00 Shaulders
.[ ooo? 2.220.00 Landzcaping
.[ ooos 1.500.00 Signal and Lighting
.[ oaog 0.00 Mizcelaneous
.[ m_ Exarple Group Description
4| | ’

Groups |.6.Illtems| Eutra Datal

L Nom[

Click on the green “GO” (to get the following screen).



ADDING ITEMS:

& Estimator - [Estimate MO2615177] =N = ==

€ File Edit ‘View Tools Window Help S
ODEE| v & & e 4 W
=8, Project No, MO2615177

o Girou Grou

[]--&l Group 0001 Preliminary ﬂumlger: |UU1U Totall::l |U.UU
[]--El Group 0002 Grading

El Group 0003 Drainage At Code:
[]..% group ggg: Zl:wnlgd Group Description
[#]- roup oulders == -
[]--El Group 0007 Landscaping B | L | u | ﬁ = | = | = | —
-, Group 0008 Signal and Lighting Example Group Description

El_ Group 0009 Miscellaneous

ﬁ Group 0010

Page 1 | Motes |

ﬁ} Line #| Item # | Quantity | Unit | Unit Price | Extension | Alt Code Descnption

lterns | Extra Data |

Ready T4LURA

Click in the Line # box in the Grid area.

302448 48 INCH REINFORCED CONCRETE PIPE, CLASS v LF
& Estimator - [Estimate MO2615177] 302454 54 INCH REINFORCED CONCRETE PIPE, CLASS IV LF =5 =m0
€ File Edit View Tools Window Help 302460 50 INCH REINFORCED CONCRETE PIPE, CLASS IV LF d ===
DIl o | b e B S S | R AENFORCED CONCHETE P LA v i
£, Project No. MO2615177 B 302478 78INCH REINFORCED CONCRETE PIPE, CLASS I LF
e B, Group 0001 Preliminary Numbe: 1302484 64 INCH REINFORCED CONGRETE PIPE. CLASS IV LF
-8, Group 0002 Grading 302512 12INCH REINFORCED CONCRETE PIPE, CLASS V LF
-8}, Group 0003 Drainage ACode: || 3eie 15 INCH REINFORCED CONCRETE FIPE, CLASS V LF
-8}, Group 0005 Paving Group Descriptiq 302518 18 INCH REINFORCED COMCRETE PIPE, CLASS LF
- &), Sroup 0006 Shoulders B | I | 1 |302521 21 INCH REINFORCED CONCRETE PIPE, CLASS Y LF
-8}, Group 0007 Landscaping = |302524 24 INCH REINFORCED COMCRETE PIPE, CLASS LF
e8], Group 0003 Signal and Lighting Ewample Group| 302507 27 INCH REINFORCED COMCRETE PIPE, CLASS v LF
8}, Group 0009 Miscellaneous 302530 30 INCH REINFORCED COMCRETE PIPE, CLASS v LF
= @_ Group 0010 Exarmple Group Descriptior 302533 33 IMCH REINFORCED COMCRETE PIPE, CLASS Y LF
ol Ttem 30253 38 INCH REINFORCED COMCRETE PIPE, CLASS v LF
302542 42 INCH REINFORCED COMCRETE PIPE, CLASS v LF
302548 48 INCH REINFORCED CONCRETE PIPE, CLASS v LF
302554 54 INCH REINFORCED CONCRETE PIPE, CLASS v LF
302560 60 INCH REINFORCED CONCRETE PIPE, CLASS ¥ LF
302566 65 INCH FEINFORCED CONCRETE PIPE. CLASS LF
Page 1 @ CH REINFORC )
304112 12 INCH CORRUGATED STEEL PIPE. 16 GAUGE L3 LF
ﬁ} Line # 304115 15 INCH CORRUGATED STEEL PIPE. 16 GAUGE Supple
€ [Tl b lternz | Extra Data |
Ready MM

Type in your Line Number 1001 or keep it as it appears 0005 (PES will renumber these correctly).

Tab over to Item #. Type in the six digit category code number or go through the list and find code (see next
page).

Tab over to fill in Quantity.

Tab over twice to fill in Unit Price (DON’T CHANGE UNIT).



& Estimator - [Estimate MO2615177] =2 E=R==
E File Edit View Tools ‘Window Help — =] =
DEE - & &l & =

=i, Project Mo, MO2ELILTT

Group

- G
..Q Group 0001 Preliminary Number o010 Tooup [50.000.00

-, Group 0002 Grading

[, Group 0003 Drainage A Cade:

% group ggg: ::Vm‘gd Group Description

-- raup oulders = = = =

&L Group 0007 Landscaping B | £ | g | alae = | = | =

-, Group 0008 Signal and Lighting E xample Group Description

El Group 0009 Miscellaneous
£1-45 Group 0010 Example Group Description
Lo T Ttern 302572

Page 1 | Notes |

ﬁ} Line # Item # | Quantity | Unit | Unit Price| Extension | Alt Code Description Supplemental Description Price Sourc

@/ a0; £.000.00 2500000 15000000 | 72INCH REINFORCED CONCRETE FIPE. C

Iterns | Extra Data ‘

Ready UM

Alternate Way to Order Items:

To Sort Items in a Group (Category) by Numerical Order According to Category Code:
e Click on a Project Group (Category) from the left side of screen which will then display on the right
hand side.
e Click on the column heading ITEM #.

Renumber Selected Items within a Group (Category)

1. Select a Project Group (Category) on the left side of the screen to display on the right.
2. Highlight the items to be renumbered in the Line # column.

3. Right Click on these numbers and select Renumber Items

4. Or Select Edit then Renumber Item Numbers.

5. Enter the desired Starting Line Number and Click OK.




Category Code List

4" Estimator SR i AMCE [ AFFI
File Edit ‘iew Tools ‘Window Hel120510 MAIMTENAMCE OF TRAFFIC 1
DEE| 2| & & {12050 GLARE SCREEM FOR MAINTEMANCE OF TRAFFIC
- 120540 BAME RUN GRAVEL SUEBASE FOR MAIMTENANCE OF TRAFFIC
120552 CRUSHER RUN AGGREGATE CR-5 FOR MAINTENANCE OF TRAFFIC
EI--E_E ATS5Z15124 120555 GRADED AGGREGATE BASE FOR MAINTEMANCE OF TRAFFIC
=y 0101 120561 HOT Ml ASPHALT FOR MAINTEMANCE OF TRAFFIC
----- I ooos 120565 HOT MI¥ ASPHALT CURE FOR MAINTEMAMCE OF TRAFFIC
""" I oo 120571 STEEL PLATE 8FO0T %12 FOOT %1 INCH FOR MaINTENANCE OF TRAFFIC REMTAL PER
""" I oos 120610 ARROW PANEL
3 { ggig 120611 PORTABLE FLASHING ARROW PANEL. RENTAL PER DAY
_____ e 120620 TEMPORARY TRAFFIC SIGMS TYPE Il RETROREFLECTIVE SHEETING
_____ T oo 120625 TEMPORARY TRAFFIC SIGMS HIGH PERFORMANCE WIDE ANGLE RETROREFLECTIVE Sk
_____ T oo4n 120630 TEMPORARY RAISED PAYEMENT MARKERS
120635 SIGNS FOR MAINTENAMCE OF TRAFFIC, RENTAL FER DAY
120640 REMOVAL OF TEMPORARY RAISED PAVEMENT MARKERS
120645 TRAFFIC COMES, REMTAL PER DAY
120662 REMOWAL OF EXISTING PAVEMENT LINE MARKINGS - ANY WD TH
120690 TUBILAR MARKERS
120697 REPLACEMEMT OF TUBULAR MARKER MAST
120700 TEMPORARY COMCRETE SINGLE FACE TRAFFIC BARRIER FOR MAINTENANCE OF TRAFF
120704 TEMPORARY COMCRETE BARRIER, RENTAL FER DAY
1120705 PRECAST TEMPORARY 32 INCH JERSEY SHAPE COMCRETE TRAFFIC BARRIER
120707 TEMPORARY COMCRETE BARRIER, RENTAL FER DAY v
&g =
@ o010 700000-E4, 190,000 EA 30.00000
@ 0015 700000-E, §1.000 EA 200000
@ 0020 700000-E, 81.000 EA 21.00000
@) 0025 700000-E, 190,000 EA 40.00000
)l I 0030 700000-E, 81.000 EA /oo x|
L} 3
Ready [ o [

Open the current Catalog (Category Code Book; also called Standard Item Catalog or open another Estimator
catalog or Code Table Catalog).

1. Select View Current Catalog from the Tools menu.

2. View the Standard Item Catalog by highlighting the title Standard Item Catalog in the tree area. A Grid
Area of the standard item shows in the right pane.

3. Position the opened catalog and estimate so both are visible in the Estimator Window.

4. In the Grid Area scroll to an item that you need. Click the GO button next to that item. That will show
you the detailed information for the item and highlight it in the tree view.

5. Select the item in the tree view. While pressing and holding down your left mouse button, drag that
item to the correct Group number in your estimate. Estimator copies that as a new item number.

6. Close the Current Catalog by making it the active window, then selecting Close from the File menu.




Supplemental Descriptions

Tab over to fill in supplemental description if needed.

Estimate PG7435126

|-, Categary (Group) 0201
Ikem 110100
Itern 110350
Ikem 120500
Itern 120610
Ikem 120625
Itern 120717
Ikem 120750
Itern 120761
Ikem 120520
Itern 120880
Ikem 121150
Itern 130840
Ikem 130850
Itern 131000
Ikem 201032
Ikern 301006
Ikem 301007
Ikem 390355
Ikem 400000-LF
Ikem 400000-5F
Ikem 400000-5F
Ikem 400000-5F
Ikem 445305
Ikem 662182
Ikem 70O0000-EA
Ikem 700000-EA
Ikem 70O0000-EA
Ikem 700000-5Y
Ikem 700000-2Y
Ikem 709110
Trern 715015

- [ - [ ] - [ ] - -

¥

][] [
e e 2 i ] e e e e e e e e e e e e e e e e e e i S e

¥

- Ei Project Mo, PG7435126 fad

Group
Total:

Group

Mumber: |U2U'I

—

Group Description

B|z|u| o

Al Code:

531,180.00

20 - ENVIRONMENTAL OMLY - NH 80%

Page 1 | Motes

ﬁ} Supplemental Description Price Source i
.[ AdHoc
(& AdHoc
m |COMCRETE POSTS &d Hoc
@@ | DOUBLE NOISE BARRIER S'YSTEM PANELS AND POSTS Ad Hoc
@@ | REMOVE EXISTING NOISE BARRIER PANELS AND POSTS Ad Hoc
@ | INSTALL/RESET WOISE BARRIER Ad Hoc
.[ Ad Hoc
.[ AdHoc
@ | MOLLIMIA CAERULEA WARIEGATA' 1 GAL CONTAIMER Ad Hoc
@m | HEMEROCALLIS [STELLAD'ORO]1 GALLOM COMTAINER Ad Hoc f
@ | LEYLAND CYPRESS, 3 GALLOM COMTAIMER 5 FOOT HEIGHT Ad Hoc
@@ | STOME MULCH, 3" DEPTH AdHoc -
: e

lterne | Extra Data

|£

Continue tabbing through until all of your items are in.

‘ Estimator
File Edit ‘iew Tools ‘“Window Help
0= & & &

€ Estimate MO2615177

=8, Project No, MO2615177

[]--&l Group 0001 Preliminary

[]--&]_ Group 0002 Grading

&]_ Group 0003 Drainage

[]--&l Group 0005 Paving

[]--il Group 0006 Shoulders

[]--&]_ Group 0007 Landscaping

[—]&l Group 0008 Signal and Lighting
g T Item 813023

-, Group 0009 Miscellaneous

Group Group
Humper: 12010 Broup [150,000.00
Alt Code:

Group Description

w|r|u| |

Example Group Description

Elﬁ Group 0010 Example Group Description
T Itern 202572

Ready

C Catalog MDCATALOGDS = B 5
E-m MDCATALOGOE E1s Item Number Description o
EEA Y Standard frem Catalog @ | 04175 15 MCH CORRUGATED STEEL PIPE, 16 GALIGE
-8, Cost Sheet Catalog @ | 30418 18 INCH CORRUGATED STEEL PIPE. 15 GAUGE =
-8, Bid History Catalag 304121 21 INCH CORRUGATED STEEL FIFE, 16
-, Reference Price Catalog :# 304124 24 INCH CORRUGATED STEEL PIFE, 16 GALGE
&l Equipment Rate Catalog
) Lobor Rate Catelog CIRESE: 27 INCH CORRUGATED STEEL FIFE, 16 GAUGE
8§ Msterial Rate Catlog @ | 304130 30 IMCH CORRUGATED STEEL PIPE, 16 GAUGE
8L Code Table PWRKTYP @ |03 32INCH CORRUGATED STEEL FIFE, 15 GAUGE
-8, Code Table SEASON @ | 04% 36 INCH CORRUGATED STEEL PIPE, 16 GAUGE
-, Code Table LIRERUR @ | 304142 42 INCH CORRUGATED STEEL FIFE, 1 GALIGE
-8, Code Table COUNTY @ | 304143 48 IMCH CORRUGATED STEEL PIPE. 16 GAUGE
-8, Code Table UNITS @ | 304212 12 INCH CORRUGATED STEEL PIPE. 14 GAUGE
i1 ), Coce Table HWTYPE @) | 304215 15 IMCH CORRUGATED STEEL PIFE, 14 GAUGE
-, Code Table DISTRICT @ | 304213 18INCH CORRUGATED STEEL PIPE, 14 GAUGE

ArAmm EFRTST r\nnnllrw\'rl—|'\ FTEE e

A4 maner

MUk




‘ Estimataor

File Edit ‘iew Tools “Window Help
D@ oo RS e t=>v] |
€ Estimate MO2515177 (o= =]
=B, Project Mo, MO2615177 5 5
-8, Group 0001 Preliminary b Joot ToeuP [150,000.00

[]--&l Group 0002 Grading

&]_ Group 0003 Drainage

[]--&l Group 0003 Paving

[]--&l Group 0006 Shoulders

[]--&l Group 0007 Landscaping

[—]&l Group 0008 Signal and Lighting

a- T Tem 813023

&]_ Group 0008 Miscellaneous

-5, Group 0010 Example Group Description
T Iern 302572

Alt Code: I

Group Description

n| sl

Example Group Description

C Catalog MDCATALOGS

E=8/EEN

302560
302566
302572
304112
304115
304118
----- 304124
----- 304127
304130
304133
304136
304142
304143
304212
304215
304218

Item Code: |3u41 i

Description

olrlul sl =[=|=| =

21 INCH CORRUGATED STEEL PIPE. 16 GAUGE

[~ Require Supplemental Description

W Trmeport
LUnit: ILF 'l Lnit Spstem: IE 'l

Page 1 I Motes I

Ready MNURA v
‘ Estirnator EI
File Edit Wiew Tools Window Help
DwH oo RS et |
€ Estimate MO2515177 (== ][=]
=8, Project Mo, MO2615177 5 5
- B, Group 0001 Preliminary Nimbe |0010 ToeoF |150,000.00

[]--&l Group 0002 Grading

&]_ Group 0003 Drainage

[]--&l Group 0005 Paving

[]--&l Group 0006 Shoulders

[]--&l Group 0007 Landscaping
[—]&l Group 0008 Signal and Lighting
- T Itern 813023

E]_ Group 0009 Miscellaneous
B3y Group 0010 Example Group Description
T Iern 302572

T Iem 304121

Ready

Alt Code: I

Group Description

n|c|ul

Example Group Description

C Catalog MDCATALOGDS

302560
302566
302572
304112
304115
304118
----- 304124
304127
304130
304133
304136
304142
304143
304212
04215
304218

Item Code: |3u41 i

Description

B|s|u|

21 INCH CORRUGATED STEEL PIPE. 16 GALGE

[~ Require Supplemental Description

W Trmeport
Lnit: ILF 'l Unit System: IE 'l

Page 1 I Motes I
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Assigning users to your particular estimate:

Select Estimate Users from the Edit menu. Estimator opens the Estimate Users Window.
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The Engineer’s Estimate Users List displays four fields for each person authorized to open your engineer’s
estimate. (See table below.)

e Click on Add.

e Add the SHA person to whom the file will be sent.

e Click on Apply.

e Click on OK.
U The Username field displays the username of an Estimator user Authorized to open the
sername i :
estimate file.
Agency The Agency field is used to determine to which agency a user belongs — use ‘MDSHA'.
Location The Location field determines where in the agency a user belongs — use ‘00000’.

The Estimate Access field displays your permission or clearance level for the active

Estimate Access .
estimate.

OWNER permission means that user can view any window and edit any data in an
estimate, including the Estimate Users List.
Automatically assigned to the person creating a new estimate.

USER permission means that user can view any window and edit any data in an
estimate, including the Estimate Users List.

However, unlike a user with OWNER access, this user cannot edit anyone on the Users
List that has OWNER access.




WRITE permission means that user has clearance to view and edit any window in an
estimate.

READ permission means that user has clearance to view any window in the estimate. A
user with read permission cannot edit or change any data.

Adding users to the Master User List

This list contains the username of each user authorized to use Estimator. If someone name is not in the list,
they cannot be given permission to open an estimate. To add, change or delete users from the list, please
contact SHA via the email addresses published on the AASHTQO'S TRNS*PORT© ESTIMATOR SHA web page
with the person’s name, Agency, Location and identify whether the information is entered in lowercase, Title
case, or UPPERCASE.
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Click on File and Save

e Estimator will automatically use your contract number as the file name.
e This “.est” file, along with any Special Provisions, will be sent electronically to the Project Manager,
Project Engineer, Landscape Architect, etc., for advertisement of the project.


http://www.roads.maryland.gov/Index.aspx?PageId=35

Printing an Estimate
Estimator uses Crystal Reports to produce a printout of your estimate. When you print an estimate, detailed
information about the price basis being used for each item can also be printed if specified.

e Open the estimate you want printed.
e Select PRINT PREVIEW from the FILE menu. Estimator displays an Estimate Print Options box that
contains several options.

Print Options Box
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Estimate Print Options @
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Show Item Descriptions If selected, includes Item Description and Supplemental
Description with above information.

Show Price Bases Details Select - None, Summary or Detailed includes Item
Description and Supplemental Description with above
information.

Show Inactive Price Bases If selected, includes a report with Price Bases

information.
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Test Estimate MO 2615177

Estimated Cost:$704,519.75

Contingency: 0.00%

Estimated Total: $704,519.75

MD #10from Park Avenue to MD BB0 [5 afety and Resurfacing]
Base Date: 12/05/12

Spec Year: 08

LInit System: E

Woark Type: URBAMN STREET RECOMNSTRUCTION
Highway Type: SAFETY AND RESURFACE
UrbaniRural Type: URBARN

Season: SPRING

County: MONTGOMERY
Midpaint of Latitude: 390000
Midpoint of Longitude: 770000

Dristrict: 3

FederaliState Project Mumber. MO 2615177

Estimate Type: SAFETY AND RESURFACING

Prepared by Tom Revelie on {2/0391
Checked by Tom Revelie on {2/08481
Approved by Tom Revelie on 12/1217
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Normal Detail Estimate
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Estimate: MO 26158177
Line # Item Number Quantity Units Unit Price E xtension

Group 0001: Preliminary
aoot 110360 1.00 LS $40,000.00000 $40,000.00
nooz 114005 8,600.00 LF $0.20000 §1,720.00
noo3 114010 1,000.00 LF §0.20000 $200.00
noo4 114035 100.00 LF $0.30000 $30.00
noos 114045 100.00 LF $0.40000 $40.00
noos 1142145 8,600.00 LF $1.00000 $8,600.00
Qooy 114220 1,000.00 LF $1.00000 §1.,000.00
noog 114235 100.00 LF §3.00000 $300.00
aoog 114245 100.00 LF §6.00000 $600.00
0o10 114275 9,800.00 LF F0.50000 $4,500.00
o1 120500 1.00 LS $52,875.00000 $52,875.00
0012 1205855 2500 TOMN $30.00000 $750.00
0013 120561 5000 TOMN $100.00000 §5.000.00
no14 120610 100.00 WD $40.00000 $4,000.00
0015 120625 125.00 SF $15.00000 §1.875.00
0016 120784 100.00 LF §2.00000 $200.00
ao17 120820 160.00 EA $65.00000 $9.750.00
o018 120860 75.00 WD $100.00000 F7.500.00
0o19 1208490 75.00 UD 15000000 $11,250.00
o020 130840 1.00 LS $15,000.00000 $15,000.00
aoz1 130850 1.00 LS $659,438.00000 $69,438.00

Total for Group 0001:$235,032.00

Group 0002: Grading
nozz 201031 1000 CY $100.00000 §1,000.00
0oz3 201032 14.00 CY $40.00000 $560.00
0024 202065 1000 CY $40.00000 $400.00
0025 203030 1000 CY §110.00000 §1.100.00

Total for Group 0002:$3,060.00




Report with Item Description
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Estimate: MO 2618177

Line # [ltem Humber Quantity Units Unit Price Extension
Description
Supplemental Description

Group 0001: Preliminary

0001 110360 1.00 LS $40,000.00000 $40,000.00
TYPE & EMGINEERS OFFICE

0002 114004 8,600.00 LF §0.20000 §1,720.00
A INCH YELLOW MONTOXIC LEAD FREE WATERBORMNE PAVEMENT MARKING PAINT

0003 114010 1,000.00 LF §0.20000 $200.00
A INCHWHITE MORNTOXIC LEAD FREE WATERBORME PAVEMENT MARKING PAINT

noo4 114035 100.00 LF $0.30000 $30.00
12 IMCH WHITE MOMNTOXIC LEAD FREE WATERBORMNE PAVEMEMNT MARKIMG PAINT

noos 114045 100.00 LF $0.40000 $40.00
24 IMCH WHITE MOMTOXIC LEAD FREE WATERBORNE PAVEMEMNT MARKIMG PAINT

noog 114214 8,600.00 LF $1.00000 $8.,600.00
5IMCHYELLOYW REMOVABLE PREFORMED PAVEMENT LINE MARKINGS

aooy 114220 1,000.00 LF $1.00000 $1.,000.00
5INCHWHITE REM OVABLE PREFORMED PAYEMENT LINE MARKING S

noog 114235 100.00 LF $3.00000 $300.00
12 IMCH WHITE REMOYABLE PREFORMED PAYEMENT LINE MARKINGS

noos 114245 100.00 LF $6.00000 $600.00
24 IMCH WHITE REMOYABLE PREFORMED PAYEMENT LINE MARKINGS

no1o 114275 9,800.00 LF $0.50000 $4.,900.00
REMOVAL OF REMOVABLE PREFORMED PAVEMENT MARKIMNGS - ANY WIDTH

ao11 120500 1.00 LS $52,879.00000 $52,879.00
MAINTEMAMCE OF TRAFFIC

no12 120555 25.00 TOM $30.00000 $750.00
GRADED AGGREGATE BASE FOR MAINTENAMCE OF TRAFFIC

0013 120561 50.00 ToM  $100.00000 §5,000.00
HOT MIXASPHALT FOR MAINTEMNANCE OF TRAFFIC

0014 120610 10000 WD §40.00000 §4,000.00
ARROW PAMEL

0015 120625 125.00 SF §15.00000 §1.875.00 -
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Report with Price Bases
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Estimate: MO 2615177

Line # Item Number Quantity Units Unit Price Extension
Description

Supplemental Description

Group 0001: Preliminary

0001 110360 1.00 LS §40,000.00000 $40,000.00
TYPE & EMGINEERS OFFICE
o000z 114004 8,600.00 LF §0.20000 §1,720.00
8 INCHYELLOW MONTOXIC LEAD FREE WATERBORMNE PAVEMENT MARKING PAINT
Regression price 114005 Active: M Unit Price: $0.22779
Root Mean Square: 0.3206298541 Standard Deviation: 0.0011638556
Guantity Coefficient: -0.1893065490 Intercept Coeffecient. 0.2355312803
[rate Coeffecient: 0.0000000000 Date Sgquare Coeffecient 0.0000000000

Weighted Average: 0.00011 78870

Infarmation: 4 matches out of 6 regression models. Model 7 isthe best fit regression model with the lowest RMS

value of 0.320630. Filtered out 2 of 6 regression madels: 0 models with positive quantity coefficient, 2 models do
not match the item.

nooz 114010 1,000.00 LF $0.20000 §200.00

5INCHWHITE NONTOXIC LEAD FREE WATERBORME PAYEMENT MARKING PAINT

Regression price 114010 Active: M Unit Price: $0.26519
Root Mean Square: 0.34509 20628 Standard Deviation: 0.0009531 826
Quantity Coefficient: -0.2358653480 Intercept Coeffecient. 390621 52 387
Drate Coeffecient: -0.00034 24320 Date Sgquare Coeffecient 0.0000000000
Weighted Average: 0.0000143440 o



Exiting Estimator
Select EXIT from the FILE menu.



